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P R E F A C E

Contents and Conventions

P.1

Overview
This preface contains the following information:
e Section P.2 discusses the overall scope e Section P.4 illustrates and describes
of the manual. conventions that appear in the manual.
e  Section P.3 briefly summarizes the e Section P.5 describes the safety
contents of the manual. guidelines and regulatory information in
the manual.

P.2

Scope of the Manual

This manual discusses the Quantum Design VersalLab instrument. It contains information about
basic functionality, describes the system hardware, and the control software.

Most VersalLab systems include measurement options that you use for performing sample
measurements. This manual discusses how measurement options interface with VersaLab, but
does not cover any details about specific options. Be sure to read separate measurement option
user manuals.

All VersaLab systems include a cryocooler system, which consists of a cold head and a
compressor manufactured by Sumitomo Heavy Industries. Please read the supplied manuals about
these components.

P.3

Contents of the Manual

e  Chapter 1 provides an overview of the e Chapter 4 describes the VersalLab
operation of the VersaLab. System Operation.

¢ Chapter 2 provides an overview of the e Appendix A contains maintenance
hardware. interval information as well as fuse and

O-rings specifications.
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e  Chapter 3 describeds the user’s interface e Alignment Appendix B provides a
and software. description of diagnostic software
operations.

e Appendix C describes system’s voltage,
frequency and power requirements, pin
out and interconnect diagrams.

P.4 Conventions in the Manual

File menu Bold text identifies the names of menus, dialogs, options, buttons, and panels
used in the VersalLab MultiVu software.

File > Open The > symbol indicates that you select multiple, nested software options.
.dat The Courier font indicates file and directory names and computer code.
Important Text is set off in this manner to signal essential information that is directly

related to the completion of a task.

Note Text is set off in this manner to signal supplementary information about the
current task; the information may primarily apply in special circumstances.

CAUTION!

Text is set off in this manner to signal conditions that could result in loss of information or
damage to equipment.

WARNING!

This symbol signals specific caution or conditions that could result in system
damage, bodily harm, or loss of life.

ELECTRIC SHOCK!

This symbol signals electrical hazards that could result in bodily harm, or
loss of life. Used at all accessible 200-230 V and 380-408 V power outlets.

WARNING!

This symbol signals cryogenic hazards that could result in bodily harm and
loss of life. Used wherever accessible parts could reach temperatures below
0°C (32°F).
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PROTECTIVE CONDUCTOR TERMINAL

The protective conductor terminal symbol in the left figure identifies the
location of the bonding terminal, which is bonded to conductive accessible
parts of the enclosure for safety purposes.

EUROPEAN UNION CE MARK

The presence of the CE Mark on the equipment signifies that it has been
designed, tested and certified as complying with all applicable European
Union (CE) regulations and recommendations.

ALTERNATING VOLTAGE SYMBOL
This international symbol indicates an alternating voltage or current.

(

switch does not fully disconnect the device from its power supply, depressing

| STANDBY SYMBOL
‘ ' The power standby symbol indicates a sleep mode or low power state. The
STSor SO e SR the button switches between on and standby.

WASTE ELECTRICAL AND ELECTRONIC
EQUIPMENT (WEEE)!

This symbol on the product or on its packaging indicates that this product
must not be disposed of with regular waste. Instead, it is the users
responsibility to dispose of waste equipment according to local laws. The
separate collection and recycling of the waste equipment at the time of
disposal will help to conserve natural resources and ensure that it is recycled
in a manner that protects human health and the environment. For
information about where the user can drop off the waste equipment for
recycling, please contact your local representative. Contact Quantum Design
for instructions on how to disassemble the equipment for recycling purposes.

This symbol signals information on fusing.
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Safety Guidelines and Regulatory Information

Before using this product, please read the entire content of this User’s Manual and observe all
instructions, warnings and cautions. These are provided to help you understand how to safely and
properly use the VersalLab and reach its best performances.

Quantum Design Inc. disclaims any liability for damage to the system or injury resulting from
misuse or improper operation of the system.

This product is NOT user serviceable except for the operations that are described as performable
by the user in Appendix A.

Observe the following safety guidelines when you use your system:

WARNING!

If the equipment is used in a manner not specified by the manufacturer, the
protection provided by the equipment may be impaired.

Do not position the equipment so that it is difficult to operate the disconnecting
device.

Inspection for Damage

The VersaLab is carefully packaged at the factory to minimize the possibility of damage during

shipping. Inspect the box for external signs of damage or mishandling. Inspect the contents for

damage. If there is visible damage to the instrument upon receipt, inform the shipping company
and Quantum Design immediately.

WARNING!

Do not attempt to operate this equipment if there is evidence of shipping
damage or you suspect the unit is damaged. Damaged equipment may present
additional hazards. Contact Quantum Design technical support for advice
before attempting to power on and operate damaged equipment.

Pressurized Gas

WARNING!

The helium compressors used with the VersalLab are charged with helium gas at
high pressure. Typical pressures found in the system can range from 0.1-2.5
MPa. This requires the operator to follow appropriate safety protocols.
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Always wear protective clothing, including eye protection, gloves and covered shoes when you
work with pressurized gas. The compressor is equipped with low loss fittings, so attaching and
removing helium hoses does not require a total venting of the system.

P.5.3

Quantum Design recommends installing oxygen sensors where the VersalLab is located
and with all other cryogenic systems.

Work with high gas pressure lines only in well-ventilated areas. In the event of a gross
helium gas leak from the gas lines, vent the room immediately and evacuate all
personnel. In a poorly ventilated area, helium can displace the air, leading to
asphyxiation. Because helium rises, well-ventilated rooms with high ceilings are
generally the safest.

Arrange the compressor lines, power and connectivity cable, and helium supply lines in a

neat manner to avoid tripping hazards.

Do not pinch the high pressure lines from the helium compressor or bend them with a
radius tighter than 60 cm (24 inches). These lines are at a pressure of about 15 bar
(300 psi). A puncture in the helium lines might cause an explosion and rapid escape of
high pressure gas.

Wear hearing protection whenever performing a cold head vent to avoid hearing loss.

Electricity

WARNING!

High voltage is supplied to the compressor making a shock hazard possible if
inadequate safety procedures are followed.

Quantum Design

In case of emergency, switch the power off at the back of the helium compressor or
unplug the main power cords from the wall power outlets.

To prevent electrical shock, unplug the system before you install it, adjust it, or service
it. Permit only qualified electricians or Quantum Design personnel to open electrical
enclosures, and perform electrical servicing and checks. To prevent electrical shock,
disconnect the compressor from the power before you install it, adjust it, or service it.

Keep electrical cords in good working conditions, and replace frayed and damaged
cords.

Do not replace detachable MAINS electrical supply cords with inadequately RATED
electrical cords.

For continued protection against fire hazard, electric shock and irreversible system
damage, replace fuses only with same type and rating of fuses for selected line voltage.

Information about user-accessible fuses and their replacement is summarized in Section
A.6.
In general, keep liquids away from the VersaLab and helium compressor unit.

Keep the Versalab and helium compressor away from radiators and heat sources.
Provide adequate ventilation to allow for air cooling around the compressor.

PPMS VersalLab User's Manual, 1300-001, Rev. B2 Xiv
September 2015



Section P.5

Preface

Safety Guidelines and Regulatory Information Contents and Conventions
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Remove the Power and Connectivity cable from the back of the VersaLab before
connecting or disconnecting the cold head cable. Failing to observe this precaution may
result in electrical shock.

If the compressor is used in a way not specified by Quantum Design, then the protection
provided by the equipment may be impaired.

Be sure to follow circuit breaker specifications outlined in the helium compressor
manual.

P.5.3.1 TURNING OFF THE HELIUM COMPRESSOR

e  Make sure the helium compressor is turned off before connecting or
disconnecting the cold head cable. Failing to observe this precaution may result
in electrical shock.

e  Set helium Compressor to “OFF” state by depressing once the “RUN” button on
the front control panel. The front panel will then display: “OFF by REMOTE
CTRL”. Note that it might take a few minutes for the Cold Head to stop. Once
the Cold Head is completely stopped proceed to the next step.

e  Power down the indoor compressor by toggling the switch in the back of the
indoor compressor control unit. This will shut down any 200-240 V power.

e Disconnect the 200-240 V power by turning off the Low Voltage breaker.

e  Unplug the compressor power cords from the power source if needed

Moving the Versal.ab

WARNING!

Never operate the VersalLab on uneven surfaces or on inclines greater than
a 1:12 ratio.

VersalLab may be moved in one of two ways:

One person may roll VersaLab to the desired location using the wheels on the back of the
assembly. To do this, place one foot on the wheel axle and pull back on the round
stainless steel handle at the rear of VersalLab as shown in Figure P-1. Then simply roll
the instrument to the desired location. Take care not to suddenly lower the instrument, as
doing so could cause damage.

Two people may simply lift VersalLab and carry it. To do this, two people stand, one on
either side of VersaLab, and pick up the instrument by the rectangular cross-section
stainless steel bar. Carry it to the desired location and carefully set it down.
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Figure P-1. How to move the VersalLab with one person (a), or two people (b).

WARNING!

Be careful when moving VersaLab. Do not drop the instrument, because
doing so could cause damage. Do not attempt to lift the instrument by
yourself, because doing so could cause injury. Take care not to damage the

high-pressure gas lines when moving the instrument.

P.6  Disposal Information

The Versalab is exempt with the requirements of:

DIRECTIVE 2011/65/EU OF THE EUROPEAN PARLIAMENT AND OF THE
COUNCIL of 8 June 2011 on the restriction of the use of certain hazardous substances in
electrical and electronic equipment (RoHS 2)

The VersalLab complies with the requirements of:

DIRECTIVE 2012/19/EU OF THE EUROPEAN PARLIAMENT AND OF THE
COUNCIL of 4 July 2012 on waste electrical and electronic equipment (WEEE)

P.6.1 RoHs Statement
RoHS Statement: The VersalLab is a Research and Development instrument that falls into
Category 9 RoHs exemption.
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P.6.2  WEEE Statement

WEEE Statement: The VersalLab is WEEE compliant as Quantum Design uses recyclable
materials in the fabrication of the equipment. Several components require special handling and
processing and these components must be removed at the time of decommissioning for proper
handling before recycling/disposal. Contact Quantum Design for updated
procedures/recommendations before disposal.

Table P-1. List of Components to be removed before Recycling or Disposal

Component Description / Location Identifying Photograph/Diagram

VersaLab Controller (QD P/N.: 7302-251)

Cryogenic Cooling System: Sumitomo cold
head, RDK 101 with integrated motor (QD
P/N.: 4302-040-01).

VersalLab Backplane (Qd P/N.: 3305-020)

H-Plate VersaLab (QD P/N.:4372-038)

XVii PPMS VersalLab User's Manual, 1300-001, Rev. B2 Quantum Design
September 2015






Preface Section P.6
Contents and Conventions Disposal Information

Display Panel Assembly (QD P/N.: 4601-
061-01)

Compressor Controller Assembly (QD P/N:
4601-130-01)

Helium Scroll Capsule (QD P/N: HM504)

Electronics Bay Assembly (QD P/N: 4601-
160)
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CHAPTIER 1

Getting Started

1.1

Overview

This chapter provides a brief introduction to the VersaLab and describes how to perform some
common tasks. Be sure to read the rest of the manual to become familiar with the details of the
system.

1.2

Introduction

The Quantum Design VersaLab is an instrument designed to measure a variety of a sample’s
physical properties while controlling the conditions experienced by the sample: temperature (400
to 50 K), magnetic field (up to 3 T), and atmosphere (atmospheric pressure to high vacuum).
VersaLab is a cryogen-free instrument, so no costly liquid cryogens are required to operate the
instrument. Instead, VersaLab uses a cryocooler to achieve cryogenic temperatures. VersalLab is a
highly automated instrument, so it can perform unattended measurements after the user has
installed a sample and configured the measurement.

VersaLab is a very flexible instrument, able to perform a wide variety of measurements, including
magnetic, electrical transport, heat capacity, and thermal transport. VersaLab achieves this
flexibility through the use of a standardized cryogenic electrical and thermal interface (the puck
interface), modular measurement electronics (CAN modules), and modular software design
(MultiVu plus measurement option software).

VersaLab is similar to another Quantum Design instrument, the Physical Property Measurement
System (PPMS). VersaLab and the PPMS share the sample puck interface, sample Lemo
connector wiring, and measurement option hardware. VersaLab and the PPMS use similar
versions of the MultiVu software for instrument control and automation. The software for
measurement options is also quite similar in the two instruments. If you are a PPMS user, much of
what you know about operating the PPMS will help you to operate VersaLab. However, there are
important differences between the two instruments, so you should read this manual.

The rest of this chapter describes some common tasks performed when using VersaLab. After
reading this chapter, be sure to read the rest of the manual in order to learn more about the
hardware (Chapter 2), software (Chapter 3), and system operation (Chapter 4). You may also want
to consult the appendices to learn about maintenance (Appendix A), diagnostic software
(Appendix B), and interconnect and pin-out diagrams (Appendix C).
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1.3

1.3.1

1-2

Common Tasks

The most common tasks you perform when using VersaLab are those required to carry out a
sample measurement: mounting the sample, inserting a sample puck into VersaLab, and setting up
a measurement option. The sections below describe these procedures.

Sample Mounting

Sample mounting techniques vary widely depending on the type of measurement you perform.
Consult the appropriate measurement option manual for information about sample mounting
methods. This section describes some general issues to consider when mounting samples. Also, if
you are not using a measurement option supplied by Quantum Design, consult this section for
mounting information.

Several broad considerations affect the choice of sample mounting technique in VersaLab.
Consider the following list before choosing a technique.

e  Thermal contact. Good thermal contact is required in order for the sample chamber
thermometer (or option thermometer) to accurately report the sample temperature.
Securely mounting the sample to a puck is one way to achieve good thermal contact.
Two common mounting techniques are to use grease or varnish. Be sure that any grease
you use does not melt in the temperature range of interest.

e  Electrical contact. For many measurements you must make good electrical contact to
your sample. Exactly how you do this depends on the details of your sample. Example
techniques include solder, welding, and metal-filled paints.

e  Ground isolation. In general, the sample must be isolated from ground if you are
performing electrical measurements. The puck is grounded, so you must isolate your
sample from the puck. One way to electrically isolate a sample, but still achieve good
thermal contact, is to place cigarette paper soaked in varnish between the puck surface
and sample. Samples already mounted to an insulator, such as a thin film on an insulating
substrate, require no additional isolation.

e  Magnetic background. If you are performing magnet measurements, consider the
magnetic background of your mounting hardware. Consider measuring an empty sample
holder to determine the size of the background.

o Differential contraction. As temperature changes, materials contract at different rates.
This may cause leads to pop off the sample, the sample to pop off the puck, or epoxy
joints to fail. Consider using thermally matched materials to avoid this problem. Any
material, such as epoxy, that is not well thermally matched, should be kept as thin as
possible.

e Secure mounting. Your sample should be mounted securely. If it falls off during
measurement, it will be very difficult to retrieve from the sample chamber.

e C(Clearance. Your sample mounting technique must allow clearance for insertion into the
instrument. For a sample mounted to a puck, everything must fit inside the puck insertion
tool, and the groove on the outer rim of the puck should be clear for gripping by the
insertion tool. Some measurement options, such as the Vibrating Sample Magnetometer,
have sample clearances set by option hardware. See the relevant measurement option for
details.

After mounting your sample, it is useful to check electrical connections before inserting the puck
into VersaLab. Use the puck wiring test station to test your connections (Figure 1.1). Once the
puck is inserted into the test station, you may test all sample connections using the banana jacks.
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Be sure to also check for isolation between ground (the puck) and your sample leads. Templates
are supplied with measurement options to aid you in identifying the leads. A 14-pin Lemo
connector, identical to the VersalLab sample wiring Lemo connector, allows connection to
measurement option hardware for testing measurement options without inserting a puck into
VersaLab. The Lemo connector, puck connector, and banana jacks are all wired in parallel.

The test station can also be used to test pucks that are wired by Quantum Design, such as Heat
Capacity and VSM coil set pucks.

Figure 1-1. Puck-wiring Test Station

For user-designed measurements, you may wish to modify the puck to accommodate your
hardware. To do so, first unscrew the single screw in the center of the bottom of the puck and
remove the PC board assembly. The metal chuck can then be machined to add the desired features
or mounting holes. Be sure not to damage the delicate fingers or the groove used by the insertion
tool. When reinstalling the PC board assembly, be sure to tighten the screw securely so that it
does not come loose upon thermal cycling in the instrument. Otherwise, you might lose the PC
board assembly in the bottom of the sample chamber.

1.3.2 Sample Puck Installation and Removal

1.3.2.1 INSTALLING A SAMPLE PUCK

A puck that you are installing in the sample chamber may have your sample mounted on it, or it
may have measurement hardware on it, e.g. VSM coil set. Either way, use the following procedure
to install a puck. For a puck with a sample on it, you should use the measurement option sample
installation wizard to walk you through this process, because the wizard also guides you through
other important tasks such as setting up a data file. The measurement option will not give you
detailed instructions on use of the puck insertion tool, so be sure to read these instructions first.

1. Disengage the sample insertion tool by flipping up the black switch located on top of the tool
or by fully depressing the switch. Refer to Figure 1-2.
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Disengaged Disengaged Engaged

Figure 1-2. Operation of Puck Insertion Tool

2. Insert the puck, with the sample facing upward, inside the hollow cylinder that is at the
bottom of the sample insertion tool. The sample will be inside the cylinder and the connectors
and solder pads will be outside the cylinder. Refer to Figure 1-3.

3. Rotate the puck to verify that it is properly seated inside the hollow cylinder. The puck
should rotate smoothly.

4. Engage the sample insertion tool by flipping down the black switch located on top of the tool
or by releasing the switch, if it is fully depressed, so that the switch lies flat across the tool’s
handle. Refer to Figure 1-3. The tool should now grip the outer rim of the puck.

5. Verify that the puck remains properly seated in the hollow cylinder. The puck must be level,
and should not rotate easily. Gently pull on the puck to verify that the tool holds it securely.

WARNING!

An unlevel puck can get stuck in the sample chamber and can damage
the pins at the bottom of the chamber. Before inserting the puck into the
chamber, you must verify that the puck is level within the cylinder of the
sample insertion tool.

Figure 1-3. Puck Insertion Tool Connecting to Puck
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6. Verify that the sample chamber is at or above 298 K. The temperature must be at least 298 K
to prevent condensation of water or cryopumping of air into the chamber. If the temperature
is below 298 K, set it to 298 K and wait for the chamber to warm up. Use MultiVu to set the
temperature: click on the temperature display in the status bar. In the temperature dialog,
enter 298 K, 20 K/min, and select Fast Settle mode. Press the Set button. An installation
wizard in measurement option software may set the temperature for you.

WARNING!

Do not open the sample chamber if it is below room temperature. Doing so
may condense water and air in the sample chamber. Such contaminants
may form a plug in the chamber resulting in dangerous and damaging over
pressure condition on warming.

7. Verify that the magnetic field is less than 1 T (10,000 Oe). If the magnetic field is greater
than 1 T, set zero field and wait for the field to stabilize before continuing. Use MultiVu to
set the field: click on the field display in the status bar. In the field dialog, set 0 Oe, 300
Oe/sec, and select Linear approach. Press the set key.

CAUTION!

If you place the sample insertion tool into the sample chamber when the magnet is at high
field, the insertion tool will be strongly pulled into the sample chamber. The force may
overwhelm you and cause damage to the instrument.

8. Vent the sample chamber with clean, dry gas. Use MultiVu: click on the chamber atmosphere
display in the status bar (this display shows the pressure and chamber state.) Press the “Vent
Cont.” button in order to vent the chamber continuously. Do not leave the chamber in this
state for longer than necessary, because doing so wastes vent gas from the bottle you supply.
An installation wizard may vent the chamber for you.

9. Open the hinge clamp and remove the KF blank flange (and attached baffle set, if present)
from the sample chamber access port. If the blank flange is difficult to move due to low
pressure in the chamber, do not force it. Allow the pressure within the chamber to match the
external pressure before you open the sample chamber to atmosphere.

10. Remove the O-ring from the sample chamber access port.

11. Gently lower the sample insertion tool into the sample chamber puck-end first until the
sample puck touches the puck connector at the bottom of the chamber. Do not force the puck
down farther once it touches the connector.

12. Rotate the sample insertion tool slowly until the key on the puck drops into the indexing
notch. When the puck drops into the notch, you feel the puck lock into position.

13. Gently push down on the sample insertion tool in order to engage the puck interface and to
make solid electrical contact between the interface and the puck.
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WARNING!

Do not use excessive force when engaging the puck interface. The need
for excessive force may indicate a problem, such as a misaligned puck. If
you push hard you may bend the pins at the bottom of the sample
chamber.

14.

15.

16.

17.

18.

Disengage the sample insertion tool, and then raise the tool several centimeters. Be sure there
is no resistance when you raise the insertion tool. Resistance indicates the puck may have
gotten caught in the tool as you began lifting it out, and you may thus need to remove the
puck and try inserting it again.

Remove the sample insertion tool from the sample chamber.

Check that the sample chamber access port KF flange, blanking flange, and O-ring are clean.
Place the O-ring over the port, and replace the blank flange (with attached baffle set).

Place the flange clamp in position around the top of the sample chamber access port, and then
latch the clamp.

Purge and seal the sample chamber using MultiVu: click on the chamber atmosphere display
in the status bar. Press the Purge/Seal button in order to purge and seal the sample chamber.
An installation wizard may do this for you.

The system is ready to begin an experiment. You should refer to the appropriate measurement
option manual to determine what to do next. Once you perform a measurement and verify
instrument operation, you may want to write a sequence to automate the measurement. See
Section 3.4 for a discussion of sequences.

1.3.2.2 REMOVING A SAMPLE PUCK

The procedure for removing the puck from the sample chamber is essentially the reverse of the
installation procedure. Complete the following steps to remove the puck:

1.

Verify that the sample chamber is at or above 298 K. The temperature must be at least 298 K
to prevent condensation of water or cryopumping of air into the chamber. If the temperature
is below 298 K, set it to 298 K and wait for the chamber to warm up. An installation wizard
in measurement option software will set the temperature for you.

WARNING!

Do not open the sample chamber if it is below room temperature. Doing so
may condense water and air in the sample chamber. Such contaminants
may form a plug in the chamber resulting in a dangerous over pressure
condition on warming.

2.

Verify that the magnetic field is less than 1 T (10,000 Oe). If the magnetic field is greater
than 1 T, set zero field and wait for the field to stabilize before continuing.
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WARNING!

If you place the sample insertion tool into the sample chamber when the
magnet is at high field, the insertion tool will be strongly pulled into the
sample chamber. The force may overwhelm you and cause damage to the
instrument.

3. Vent the sample chamber with clean, dry gas. An installation wizard may do this for you.

4. Open the hinge clamp and remove the KF blank flange (and attached baffle set, if present)
from the sample chamber access port. If the blank flange is difficult to move due to low
pressure in the chamber, do not force it. Allow the pressure within the chamber to match the
external pressure before you open the sample chamber to atmosphere.

5. Remove the O-ring from the sample chamber access port.

6. Disengage the sample insertion tool by flipping up the black switch located on top of the tool
or by fully depressing the switch. Refer to Figure 1-2.

7.  Gently lower the sample insertion tool into the sample chamber cylinder-end first until the
tool touches the bottom of the chamber.

8. Engage the sample insertion tool by flipping down the black switch located on top of the tool
or by releasing the switch, if it is fully depressed, so that the switch lies flat across the tool’s
handle. Refer to Figure 1-3.

9. Gently raise the insertion tool out of the sample chamber. You should feel some initial
resistance as you pull the puck out of its seat.

10. Verify that the sample puck is in the insertion tool. If it is not, return to step 6. If it is,
disengage the lever and let the puck fall safely into your hand. Do not drop the puck.

You may insert another puck, install measurement option hardware into the sample chamber, or
close the sample chamber at this point. To close the sample chamber, you (1) place the O-ring and
KF blank flange over the sample chamber access port, (2) place the flange clamp in position
around the top of the chamber access port, (3) latch the clamp, and then (4) purge and seal the
sample chamber.

1.3.2.3 OPTION START UP

Most measurements that you perform in VersaLab require the use of a measurement option, such
as Vibrating Sample Magnetometer or Heat Capacity. Whenever you first start using an option, or
when you change from using one option to another, follow the steps outlined below. Consult the
relevant measurement option manual for details about the measurement option you are using.

1. If necessary, uninstall any hardware from a measurement option previously in use.

a. You always uninstall all option hardware from the sample chamber, including pucks,
specialized baffle sets, and hardware attached to the chamber KF flange (e.g., VSM
linear motor). Be sure the chamber is at room temperature, the magnetic field is zero, and
the chamber is venting continuously before attempting to remove any option hardware.

b. It is not necessary to uninstall CAN modules unless you need extra space in the module
bay.
2. Install hardware for the measurement option you are ready to use.

a. For some options, you install pucks, specialized baffle sets, and hardware attached to the
sample chamber. See the option manual for details. In general, you do not install
samples, including pucks with samples on them, at this time.
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b. Ifnecessary, install any CAN module(s) needed for the option into the module bay. The
module(s) may already be installed from previous use of the option. See Section 2.6.7 for
details on insertion of CAN modules.

Activate the option software. In MultiVu, select the menu item “Utilities > Activate
Option...” You will be presented with a dialog showing available options. Select the desired
option and press the “Activate -->>" button. The option software will start within the
MultiVu window, and will initialize the option hardware.

Install your sample. Use the measurement option installation wizard, because it guides you
through all the necessary steps, including setting up data files and entering sample properties.

Perform an immediate mode measurement using the measurement option control panel in
order to verify that everything is working correctly.

Write a sequence to automate the measurement. Execute the sequence, and allow the
instrument to acquire data. See Section 3.5 for information about writing and executing
sequences.

When the measurement sequence is complete, remove your sample using the option’s wizard.
Then either install a new sample to measure, or go back to step 1 to use a different
measurement option.
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CHAPTER 2

Hardware

2.1 Overview

This chapter describes the VersaLab hardware components and their functions. You should have a
basic understanding of the theory of operation of the system after reading this chapter. Although
this chapter will help you understand how to operate the instrument, user operation is not
described in this chapter. See Chapter 1: Getting Started, and Chapter 4: System Operation for
operating instructions.

The VersaLab instrument is entirely contained within a single enclosure that includes the cryostat
and electronics cabinet. The compressor and control computer are separate from this enclosure.

2.1.1 Cryostat

The cryostat assembly is contained in the front half of the VersaLab enclosure. Figure 2.1 shows a
cutaway view of the cryostat.

Figure 2 - 1. Main Cryostat Systems
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The cryostat consists of the following systems, described in the sections below:

Cryogen-Free Cooling System. This system allows VersaLab to achieve cryogenic
temperatures without the need for liquid cryogens, and is described in Section 2.2.

Temperature Control System. This system controls and measures the temperature of the
sample, and is described in Section 2.3.

Magnetic Field Control System. This system controls the magnetic field at the sample,
and is described in Section 2.4.

Chamber Atmosphere Control System. This system controls the gas atmosphere at the
sample, and is described in Section 2.5.

Electronics Cabinet

The electronics cabinet is contained in the rear half of the VersaLab enclosure. This cabinet
contains all of the hardware needed to control the cryostat systems. See the cryostat sections for
descriptions of the electronic components used by each cryostat system.

The electronics cabinet contains the following components:

Controller Board, which is involved in the control of all VersaLab systems.
Magnet Controller, which supplies current to the superconducting solenoid.
Module Bay, which houses measurement option CAN Modules.

CANOpen-USB dongle, which allows the computer to communicate with the CAN bus
via USB.

Power supply, which supplies +24 V and —24 V to all electronics, as well as the current
to the magnet controller.

Figure 2 - 2. Main Components of the Electronics Cabinet
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SROMs

Serial Read-Only Memory chips, or SROMs, are present in several places in VersalLab. The
SROMs are used to store calibration information about the components they are attached to. The
calibration information is read at runtime, reducing the need for calibration files on the computer.

There are 3 SROMs always present in VersaLab:
e Main SROM. This SROM is on the controller board, and is used to store general
information about the configuration of VersaLab.

e  Cryostat SROM. This SROM is on a PC board attached to the sample chamber, and is
used to store cryostat calibration information, including thermometer tables and magnet
calibration.

e  Magnet Controller SROM. This SROM is in the Hybrid Feedback Enclosure on the
Magnet Controller, and is used to store Magnet Controller calibration information.

In addition, measurement options have SROMs to store calibration information for measurement
hardware.

Control Computer

A standard personal computer is used to control VersalLab. The computer connects to VeraLab
via USB through the CANOpen-USB dongle.

2.2

2.2.1

Cryogen-Free Cooling System

The core difference between VersalLab and traditional cryostats is the cryogen-free cooling
system. This system allows VersalLab to perform temperature dependent measurements in a
magnetic field without the use of any liquid cryogens. The components of the cryogen-free
cooling system are described below.

Cryocooler

Versalab is cooled using a two-stage helium cryocooler comprised of a compressor, cold head,
and high pressure gas connecting lines. The compressor provides helium gas at approximately 2
MPa to the cold head through high pressure flexible gas lines. Cooling is accomplished when this
high pressure helium gas is expanded in the cold head. The expanded gas is then recompressed in
the compressor. A displacer in the cold head, driven by a motor at room temperature, provides
regenerative exchange to the helium gas. A cable connects this motor to a drive circuit located on
the compressor.
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Figure 2 - 3. VersalLab Cold head and Compressor

The cold head provides cooling in two stages. The first stage provides approximately 5 W of
cooling power at 60 K, and the second stage provides approximately 0.1 W at 4.2 K. The first
stage of the cooler is used for many cooling tasks, including the sample chamber, thermal shields,
and capturing heat leaks from components connected at room temperature. The second stage is
used primarily to cool the superconducting magnet and the charcoal pot of the thermal switch.
The sections below detail how each system is cooled by the cryocooler.

See Section 4.2.1 for instructions on how to set up the compressor and connect the high-pressure
helium lines. See Appendix A.4 for cryocooler maintenance information. For a detailed
description of the cryocooler, consult the manufacturer’s manual that was included with your
system.

2.2.1.1 CAUTION AGAINST HAZARD

WARNING!

In order to avoid damage and bodily injury due to the high pressures and low
temperatures present in the cryocooler, follow these precautions

e Take care to not damage the high-pressure helium lines, as doing
so could cause sudden release of gas.

e Do not bend the high-pressure gas lines with a radius smaller than
30 cm (12 inches). Doing so could causes damage to the lines and
sudden release of gas.

e Do not connect or disconnect the high-pressure helium lines without
consulting Quantum Design.

e Never disconnect the high-pressure helium lines while the system is
cold. Doing so causes extremely high pressure in the cold head,
resulting in loss of gas through a check valve and possible damage
to the cold head.

e Do not attempt to perform any maintenance on the compressor or
cold head without consulting Quantum Design.
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Thermal Isolation

The cold components of the Versalab cryostat must be thermally isolated from each other and
room temperature. Vacuum and thermal shields provide this isolation.

Vacuum and Charcoal Sorbs

The Versalab thermal isolation vacuum is provided by charcoal sorbs connected to the first and
second stage of the cryocooler. Before cooling the system down, the diaphragm pump evacuates
the cryostat case to <2 Torr. During cool down, the charcoal adsorbs the remaining gas in order
to provide high vacuum isolation. Note that very small quantities of helium present during a cool
down can cause a high enough heat leak to prevent a proper cool down. You avoid the presence of
helium by utilizing the cool down wizard described in Section 4.3.

Permeation through the various O-ring seals in VersaLab could ruin the isolation vacuum.
However, the charcoal sorbs (and other cold surfaces) adsorb permeated gases, maintaining the
vacuum. When the system is warmed up, these gases desorb. Therefore, the case vacuum needs to
be pumped down as described in Section 4.3 before every cool down.

Thermal Shields

Even with a perfect isolation vacuum, thermal radiation can result in large heat leaks to the cold
cryostat components. Thermal shielding reduces this heat leak. Most cold components reside
inside a shield cooled by the cryocooler first stage. Superinsulation reduces the radiation heat load
on this shield. A shield cooled by the cryocooler first stage between the magnet and sample
chamber allows the magnet temperature to be < 4 K while the sample chamber is at 400 K.

Diagnostic Thermometers

Versalab is equipped with diagnostic thermometers in order to help determine whether or not the
cryogen-free cooling system is operating correctly. Diagnostic thermometers are present on the
cryocooler first and second stages, the magnet, and the thermal switch charcoal pot. These
temperatures are available in Log Data as described in Appendix B.2. Typical values for these
diagnostic temperatures are given in Appendix A.4.1.
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2.3  Temperature Control System

There are four main components in the VersaLab temperature control system, described briefly
here. These components, other than the cryocooler, are described in more detail in the sections
below:
e  The sample chamber, which contains the sample puck, thermometers for measuring the
temperature at the puck, and heaters to provide warming.

e  The thermal switch, which provides a variable thermal link between the sample chamber
and cryocooler first stage.

e The cryocooler. The first stage of the cryocooler is connected to the sample chamber via
the thermal switch. The second stage of the cryocooler cools the charcoal pot on the
thermal switch.

e Versalab control electronics, which measure thermometers and apply appropriate heater
powers to achieve temperature control.

WARNING!

Note that unlike the PPMS sample chamber, the VersalLab sample chamber
is not removable from the top of the instrument. The VersaLab sample
chamber is connected via flexible links to components inside the cryostat. Do
not attempt to remove the sample chamber from VersalLab, because doing
so can damage the instrument.

2.3.1 Thermal Switch and Thermal Circuit

SAMPLE
CHAMBER

% CRYOCOOLER
1ST STAGE
THERMAL
SWITCH

CRYOCOOLER
2ND STAGE

Figure 2 - 4. Block Diagram of VersalLab's Temperature Control Thermal Circuit.
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Unlike most cryostat temperature control systems, VersalLab temperature control involves no bulk
gas flow. Instead, VersaLab utilizes solid and variable conduction in order to provide variable
cooling power to the sample chamber. VersaLab performs gross temperature control by selecting
this cooling power to roughly match the ramp condition or stable temperature requested by the
user. Standard feedback control using heaters and thermometers provides fine temperature
control, allowing controlled ramps and stability to be achieved.

A proprietary thermal switch achieves variable cooling power to the sample chamber by providing
a variable thermal conductance between the first stage of the cryocooler and the bottom of the
sample chamber as shown in Figure 2-4.

The first stage of the cryocooler will warm up when the sample chamber is cooled because heat is
transferred from the chamber to the first stage via the thermal switch. As a result, rapid cooling of
the chamber at high temperatures may result in slower cooling at lower temperatures while the
system waits for the first stage to cool back down. VersaLab may not be able to maintain linear
ramps while cooling at fast cooling rates due to this effect.

Sample Chamber

THERMAL STANDOFF
REGION

\SOTHERMAL

REGION

SAMPLE PUCK INTERFACE
BREAK AWAY VIEW

Figure 2 - 5. VersaLab Sample Chamber with Sample Puck Interface shown
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The sample chamber consists of three main sections:

e  Thermal standoff region. The upper region of the sample chamber is constructed from
thin-walled stainless steel tubing, allowing one end to be at room temperature while the
other is cooled to 50 K.

e Isothermal region. The lower portion of the sample tube is constructed from high
conductivity copper in order to provide a uniform thermal environment for experiments.

e Sample puck interface. At the bottom of the isothermal region is an interface for sample
pucks. A cylindrical surface provides a thermal interface to the puck fingers. A 12-pin
hermetic electrical feedthrough provides an electrical interface to the puck, and brings
the 12 leads out of the sample atmosphere into the vacuum space. See Appendix C.3 for
a more detailed description of the sample wiring.

The temperature of the sample puck interface, called the system temperature, is measured using
the block thermometer, which is mounted to the bottom of the sample chamber in the cryostat
vacuum space. The block thermometer is near the sample puck and therefore represents an
accurate estimate of the sample temperature. However, thermal gradients will limit this accuracy
during fast slewing of the sample temperature. The most accurate temperature measurement is
made when the temperature is stable. When using a standard sample puck, slewing will typically
cause a temperature lag of about 20 seconds between the puck and block temperatures. So,
slewing at 2 K/minute will yield a 0.7 K temperature error. The value of the lag and error is
dependent on sample mounting and the mass of the sample puck.

In case the block thermometer fails, a second thermometer, the backup thermometer, is mounted
in an identical location. Versalab can be configured by Quantum Design to use either the block
or backup thermometer to measure the system temperature. If you suspect that either the block or
backup thermometers have failed, you can compare their values using the Log Data dialog. Select
the menu item “Utilities > Log Data”, and then select the Diagnostics tab. Then select the check
boxes for the block and backup thermometers. The reported temperature values should agree to
within 0.5 %. (See Appendix B.2 for more details about Log Data.)

Two heaters are mounted to the outside of the sample chamber and are used for temperature
control. The block heater is mounted to the bottom of the sample chamber, near the block and
backup thermometers. The neck heater is physically larger, and extends from the isothermal
region up into the stainless steel region of the sample chamber. These two heaters are used for
fine temperature control. When the temperature is stable or nearly so, only the block heater is
used. During warming, the neck heater and block heater are used in combination so as to
minimize thermal gradients.

Option Temperature Control and Description of Temperature
Nomenclature

When no measurement option is in use, VersalLab temperature control uses the system
temperature, measured by the block or backup thermometer, as described above. This scheme is
appropriate for samples mounted on standard pucks and in good thermal contact with the puck
interface. The Electronic Transport Option is a good example of such a measurement. However,
some measurement options, such as the Vibrating Sample Magnetometer, place the sample in a
position such that it is not in good thermal contact with the puck (and therefore the block and
backup thermometers). Therefore, these options provide an additional thermometer near the
sample. VersaLab uses this option thermometer in order to provide accurate temperature control
and temperature measurement.
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The option temperature is usually reported by the measurement option hardware to VersaLab via
the CAN bus. For details about measurement option thermometers, refer to the relevant
measurement option manual.

For clarity, the three temperatures used by the VersaLab temperature control system are:

e System temperature: represents the puck interface temperature. This is the block or
backup temperature, depending on how VersaLab is configured.

e  Option temperature: represents the sample temperature for some measurement options.
This temperature is read by a measurement option thermometer, reported to VersaLab
via the CAN bus.

e  Control temperature: the temperature that is being used for feedback control. With no
measurement option active, and for some measurement options without option
thermometers, the control temperature is the system temperature. For measurement
options that request control off of the option thermometer, the control temperature is the
option temperature.

2.3.4  Temperature Control Electronics and Firmware

All of the electronic resources for temperature control are provided by the VersalLab controller
board located in the electronics tower at the rear of VersaLab. The resources provided are:

e  Thermometry. The controller board provides excitation, read back, and table
interpolation for the following thermometers. Temperature update rates are 2 Hz on
thermometers used for feedback (normally block and switch pot) and 3.5 Hz on other
thermometers.

o Block thermometer. Used for feedback unless system is configured to use backup
thermometer or user thermometer.

o  Backup thermometer.

o User thermometer. Connected to 4-pin Lemo connector on the back of VersaLab.
This thermometer is normally used for calibration of block and backup
thermometers, but can be used to read out user-provided thermometers.

o Switch thermometer. Used for feedback control of thermal switch.

o  Diagnostic thermometers: magnet, cryocooler first stage, and cryocooler second
stage.

e Heaters. The control electronics drive the following heaters to achieve feedback control
of temperature:
o  Block heater, capable of delivering about 20 W.
o Neck heater, capable of delivering about 20 W.
o Switch heater.

In addition to providing these hardware resources, the VersaLab controller board provides all
temperature control automation by means of the VersaLab firmware on the CPU card of the
controller board. The PID feedback control and state machine are both implemented in this
firmware. The MultiVu software simply sends commands to and receives status from the
VersalLab firmware in order to execute user-requested temperature set points.
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Magnetic Field Control System

Magnet and Leads

The magnetic field in VersaLab is generated by a superconducting niobium-titanium (NbTi)
solenoid mounted in the cryostat vacuum space. The magnet generates a vertical magnetic field.
The standard magnet generates a maximum 3 T field at approximately 20 A of current. While
most magnets are cooled by liquid or gaseous helium, the VersalL.ab magnet is cooled by solid
conduction. Copper straps connect the magnet to the cryocooler second stage in order to cool it.

The VersalLab magnet does not have a superconducting switch. Rather, the magnet controller is
directly connected, via magnet leads, to the superconducting solenoid. With no liquid cryogen to
boil off due to heat dissipated in the magnet leads, a superconducting switch is not necessary.

The magnet leads inside the cryostat consist of three stages:

e  The section between room temperature and the cryocooler first stage, which is
constructed of copper wire. The design minimizes the total heat load on the cryocooler
first stage considering solid conduction and joule heating at maximum current.

e The section between the cryocooler first and second stages, which is constructed of high
temperature superconductor, eliminating joule heating.

e The section between the cryocooler second stage and the magnet, which is constructed of
NbTi alloy, also eliminating joule heating.

Low thermal resistance, but electrically isolating thermal anchors, cool the magnet leads at the
first and second stages of the cryocooler in order to make sure that the high temperature
superconductor and NbTi sections are superconducting and to minimize heat load to the next
stage.

Magnet Controller

The VersalLab magnet controller is located in the center rear portion of the electronics tower. The
controller provides enough current and voltage to ramp a standard 3 T VersaLab magnet at 300
Oe/sec. Due to an inherently 4-quadrant design and analog current feedback, the system is able to
achieve linear field ramps with no discontinuity or kink at zero field and negligible overshoot
when stabilizing.

The VersaLab controller board and firmware automate the magnet controller. The controller
board ramps the value sent to the magnet controller DAC in order to request current set points for
analog feedback and achieve linear field ramps. The control board also reads back values from an
ADC in order to determine the voltage across a shunt resistor to measure magnet current. The
control board also monitors the magnet thermometer in order to ensure that the magnet is cold
enough to operate properly. If the magnet temperature exceeds a critical value (stored in the
cryostat SROM), then the magnet current is ramped to zero and the system declares a quench.
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Magnetic Field Accuracy, Uniformity and Magnet Reset

VersaLab reports the magnetic field as the measured magnet current multiplied by a calibration
factor determined at the factory for your magnet. (This factor is stored in the cryostat SROM.)
The system does not take magnet relaxation or trapped flux into account. For information on the
resulting field remanence, see your system specifications.

The field remanence can be reduced to a value near the earth’s field by performing a magnet reset.
See Section 4.4.3 for information about this procedure.

The uniform region of the magnetic field is centered 4.0 cm (1.6 inches) above the top surface of
a standard sample puck. See Figure 2-7. The field is uniform to within £ 0.1 % over a 2.5 cm
axial length centered at that location. VersaLab is calibrated to report the magnetic field at the
center of the uniform region. The magnetic field at the puck surface is up to 1 % lower than the
value reported by VersalLab, because the puck surface is not in the uniform region.

Magnetic Shield

A magnetic shield surrounds the VersaLab cryostat in order to reduce the field value experienced
outside the system. The field is below 5 gauss everywhere outside the VersalLab enclosure except
near the top and corners of the enclosure top tray. The field is below 5 gauss for any point at least
5 cm (2 inches) away from the top tray.

The magnetic shield also serves to protect sensitive experiments from external magnetic field
sources. For example, the shield protects the Vibrating Sample Magnetometer coil set and coil set
leads from magnetic signals originating in the VSM Linear Motor. The shield can also protect
experiments from various environmental sources that may exist in your laboratory, such as other
instruments that generate fields and magnetic building elements.

2.5

Chamber Atmosphere Control System

Many experiments carried out in VersalLab require control of the experimental atmosphere present
in the sample chamber. Any experiment that involves low temperatures requires an atmosphere
that will not freeze or condense on the sample and other experimental hardware. Some
experiments benefit from the thermal uniformity provided by exchange gas, while others require
thermal isolation provided by high vacuum. VersaLab meets all of these needs with its chamber
atmosphere control system. In addition, this system enables VersaLab to pump out the cryostat
vacuum case prior to cooling down.

The chamber atmosphere control system consists of the following components, which are
described in more detail in the sections below:

e  Diaphragm pump, which is used to pump out the sample chamber to pressures as low as
2 Torr.

e  Gas handling manifold, which contains hardware to control and measure chamber gas.
Hardware mounted to the manifold includes:

o  Pressure gauge
o  Solenoid valves
o High vacuum valve

Quantum Design PPMS VersalLab User's Manual, 1300-001, Rev. B2 2-11

September 2015



Section 2.5

Chapter 2

Chamber Atmosphere Control System Hardware

2.5.1

2.5.2

2.5.3

2-12

o KF flange and baffle set
e  Cryopump, which is used to pump the chamber out to high vacuum.

e  Vent gas, which is used to vent up the sample chamber and reduce atmospheric
contaminants in the chamber.

e  Versalab controller board, which automates the pump and valve sequencing needed for
chamber operations.

Diaphragm Pump

The diaphragm pump is capable of achieving pressures below 2 Torr. It is used to:
e Evacuate the sample chamber.
e  Pump on the cryopump during regeneration.

e Evacuate the cryostat vacuum case before cooling down a warm Versalab system.

The rubber diaphragms in the diaphragm pump have a lifetime of approximately 10,000 running
hours. Because the diaphragm pump does not run continuously in VersalLab, the diaphragms are
expected to last for many years. Normally, the diaphragm pump will be rebuilt at every other
cryocooler maintenance (see Appendix A.4). If you suspect that your diaphragm pump has worn
out and requires maintenance, please contact Quantum Design.

Gas Handling Manifold

The gas handling manifold, which is bolted to the cryostat top plate under the magnetic shield,
provides most of the gas handling. Three solenoid valves (the vent valve, pump valve, and case
valve) are mounted to the manifold. The high vacuum valve, a linearly actuated bellows valve,
provides a high conductance connection between the chamber and cryopump when open. The
pressure gauge monitors the pressure in the sample chamber. When the system is pumping on the
vacuum case, the pressure gauge can also monitor the pressure in the case.

KF Flange and Baffle Set

The sample chamber is accessed through the KF-40 flange mounted to the gas handling manifold.
In order to seal the flange and prevent thermal radiation from reaching your sample, you use the
baffle set (Figure 2-6). In order to prevent leaks into the sample chamber, be sure to keep the
sealing surfaces of the KF flange and baffle set clean. Also, be sure not to damage the O-ring used
to seal this flange.
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Figure 2 - 6. Baffle Set

A threaded adapter is present on the end of the rod in order to allow the attachment of accessories,
such as the contact baffle used with the Heat Capacity and Thermal Transport Options.

Cryopump

The cryopump is used to achieve high vacuum in the sample chamber, typically < 10 Torr. The
cryopump is permanently mounted in the cryostat vacuum case. Therefore, hardware is provided
to allow complete regeneration of the cryopump in situ while the system is cold.

The cryopump may periodically need regeneration due to the build up of contaminant gases and
adsorbed helium. When this happens, the cryopump needs to be heated up and pumped out in
order to remove the condensed and adsorbed gases, a process called regeneration. It is equipped
with a heater to reach room temperature while the system is cold without excessive warming of
the cryostat. See Section 4.4.4 for details about this procedure.

You prevent the need to regenerate the cryopump often by keeping the sample chamber clean.
Avoid placing wet objects, such as a cold baffle set that has condensed water on it, in the sample
chamber. Be sure to purge and seal the sample chamber before attempting to set high vacuum.

In order to ensure that the cryopump stages are clean before cooling down a warm system, the
cool down procedure involves regenerating the cryopump at room temperature before starting the
cool down. See Section 4.3 for details.

Vent Gas and Regulator

Unlike conventional cryostats, VersaLab does not have dewar boil off gas available for venting
the sample chamber. Therefore, you must supply a bottle of vent gas. A regulator on the vent gas
bottle sets an appropriate pressure for venting the sample chamber. The vent gas is connected to
VersaLab at the bottom rear of the base. See Section 4.2.2 for details about choice of vent gas and
connection instructions.
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Chamber Operations

Versalab supports several different chamber operations, described below. It is important to note
that any chamber operation involving pumping should be performed only when the sample
chamber KF flange is sealed. Otherwise, the chamber will not be pumped down as desired during
these operations.

Before setting a temperature below 295 K, you should always be sure that the sample chamber is
sealed and contains only clean gas. Normally you do this by executing a purge and seal operation
after sealing the KF flange at room temperature. Failure to do so can cause contaminants to freeze
inside the sample chamber, causing problems with many experiments. Measurement options
provide sample installation wizards that perform chamber operations at the appropriate times
when installing samples.

WARNING!

Be sure to properly seal the sample chamber KF flange before setting
temperatures below 295 K. Failure to do so will cause ice to build up in the
chamber, a condition that is hazardous and may damage the VersalLab
sample chamber due to excessive pressures resulting from an ice plug. Even
a small leak can cause ice to build up, so be sure to keep the KF flange
surfaces clean and to not damage the O-ring used to seal the flange.

The VersaLab chamber operations are described below:

o  Seal. Sealing the chamber simply closes all valves, leaving the chamber atmosphere
unchanged.

e Purge and Seal. Purging and sealing the sample chamber performs four cycles of
pumping out most of the chamber gas and then filling it up with vent gas. Finally, the
chamber is pumped down to a pressure that is appropriate for experiments that require
exchange gas, about 10 Torr. Normally, you purge and seal the chamber at room
temperature after installing a sample in order to clean out atmospheric contaminants
introduced while the chamber was open.

e Ventand Seal. Venting and sealing the sample chamber fills the chamber with vent gas,
and then closes the vent valve. This operation is useful when you want to conserve vent
gas, because vent gas will not flow out of the vent gas supply bottle once the vent valve
is closed. You can use this operation before opening up the sample chamber at room
temperature in order to change samples.

e Pump Continuous. This operation uses the diaphragm pump to evacuate the sample
chamber. The pump valve remains open and the diaphragm pump remains on
indefinitely. The lifetime of the diaphragm pump is shortened if the system is left
pumping continuously for extended periods.

e Vent Continuous. This operation, also known as flooding, fills the chamber with vent
gas, and leaves the vent valve open. Because the flow of vent gas is continuous, this
operation minimizes the amount of air that enters the chamber. To ensure that the vent
gas bottle is not inadvertently emptied, the vent valve will automatically seal after two
minutes.

e High Vacuum. This operation uses the cryopump to pump a high vacuum, typically
< 10" Torr, in the sample chamber. First, the diaphragm pump evacuates the sample
chamber to < 2 Torr. Then the high vacuum valve is opened, exposing the sample
chamber to the cryopump. The system declares high vacuum when the pressure gets
below 10 Torr.
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2.6.1

Measurement System

Sample Pucks and Assorted Tools

The sample puck is a unique modular component that gives VersalLab great flexibility. The puck
is the sample holder for many experiments that do not require sample motion or thermal isolation
of the sample. The Electronic Transport Option is a good example. Even when the sample is not
mounted directly to the puck surface, measurement hardware is mounted to a puck. In the
Vibrating Sample Magnetometer, the detection coil set is mounted to a puck. In the Heat Capacity
Option, the heat capacity platform and leads are mounted to a puck.

The puck is a 2.3 cm (0.91 inch) diameter disk constructed of high conductivity copper that
maintains high thermal uniformity. The puck is gold plated to prevent oxidation, providing a
surface on which samples can be mounted with good thermal contact. The system thermometers
(see Section 2.3.2) are mounted directly beneath the installed puck, providing good contact
between sample and thermometers. Measurement options that use alternate sample mounting
methods provide a thermometer close to the sample.

The base of the puck contains 12 solder pads to allow connection of the sample (or other
measurement option hardware) to the experimental sample wiring. These solder pads are
connected to a set of 12 sockets on the base of the puck, which contact pins in the bottom of the
sample chamber. The puck is keyed to ensure that the electrical connectors properly align. See
Section 2.6.5 for details on experimental wiring. See Appendix C for an experimental wiring pin
out diagram.

—_—
5.0 em
(MAXIMUM SAMPLE
HEIGHT)

4.0 cm
(MAGNETIC FIELD SOCKET

CENTER)

SOLDER PAD

SAMPLE INTERFACE
(BOTTOM VIEW)

Figure 2 - 7. Top and Bottom views of a Sample Puck
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2.6.2 Sample Insertion Tool

The puck-insertion tool is a long rod used for installing the puck in the sample space. The lever of

the puck-insertion tool is engaged when it is lying flat across the handle, as is shown in Figure
1-2. When the lever is engaged, the tool grips the puck by a groove in its outer rim.

===

Figure 2 - 8. Sample Insertion Tool with Lever in Engaged Position

The puck-insertion procedure is described in Section 1.3.2.1.

WARNING!

Read section 1.3.2.1 before attempting to insert a puck into a VersalLab.
Failure to follow the directions correctly could cause damage to the
instrument.

2.6.3 Puck Adjustment Tool

The puck adjustment tool (Figure 2-9) is used to adjust the position of the fingers of the puck so
that the fingers maintain solid thermal contact with the thermal interface located at the bottom of
the sample chamber. Use the puck adjustment tool after you have inserted the sample puck into
the sample chamber approximately 10 times or whenever the puck fits loosely into the bottom of
the chamber. Instructions for using the puck-adjustment tool are given in Section A-2.

Finger

Contractor \ Test Cutout

FINGER
SPREADER
Cylinder 1 Cylinder 2
Figure 2 - 9. Puck Adjustment Tool
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Puck Wiring Test Station

The puck-wiring test station (Figure 2-10) is used to verify the integrity of the wiring between a
sample and puck or the wiring of any option hardware present on a puck. The test station contains
three sets of contacts, all wired in parallel: a Lemo connector identical to the sample chamber
connector on the probe head, a puck connector, and 12 banana jacks. VersaLab measurement
options come with templates that label the banana jack functions when the standard cabling is
being used for an option.

Figure 2 - 10. Puck Wiring Test Station

Experimental Wiring

The experimental wiring in VersaLab consists of the following components:
e The Lemo connector under the VersalLab top cover.

e A cable between the Lemo connector and the top of the sample chamber. A magnetic
shield protects this cable from magnetic signal interference

e The cryogenic sample chamber wiring, described in more detail below.

e The vacuum tight electrical feedthrough at the bottom of the sample chamber. The
sample puck plugs into the pins at the bottom of the sample chamber provided by this
feedthrough.

Chamber Wiring Current Limits

In order to minimize heat leak down the sample chamber while allowing high sample currents to
be used, two types of sample wires are used. Four of six pairs of sample wires are designed to
minimize heat leak, and can carry a maximum of 10 mA without excessive sample chamber
heating or damage to the wires. Two of the six pairs are designed to carry high currents, and can
carry 0.5 A continuously without excessive sample chamber heating or damage to the wires. The
low current pairs are connected to pins 3-4, 7-10, and 13-14 on the puck and Lemo connector.
The high current pairs are connected to pins 5-6 and 11-12 on the puck and Lemo connector. If
you perform an experiment that requires high currents, be sure to connect the high current leads to
these pins. See Appendix C.3 for detailed pin out diagrams.
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2.6.7

2-18

CAN Modules

Measurement electronics are contained within modular electronic housings, commonly called
CAN modules. A typical CAN module is shown in Figure 2-11. Connections to measurement
hardware are made on the front panel, which is shown in the figure.

Figure 2 - 11. Model CM-A VSM Motor Module

The 9-pin QD-CAN D-shell connector on the bottom panel (Figure 2-12) of the modules connects
to power, CAN, and synchronization lines in the Module Bay, described below. One or two guide
holes are present, depending on whether the module dissipates high or low power. All slots in the

VersaLab Module Bay accept high power modules.

Figure 2 - 12. Rear Panel of the Model CM-A VSM Motor Module

CAN modules communicate with VersaLab, other CAN modules and the CANOpen-USB dongle
via the CAN bus. The PC software communicates with CAN modules using CAN over USB via
the CANOpen-USB dongle.

For a detailed description of specific CAN modules, consult the relevant measurement option
manual. For instructions on insertion and removal of CAN modules, see Section 3.2.5 (in Option
setup).
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2.6.8 Module Bay

CAN Modules reside in the Module Bay, located under the plastic lid in the VersalLab electronics
tower. The Module Bay provides power, CAN, and synchronization lines to modules. Any
module may be inserted into any slot in the Module Bay, because all slots are high power slots.

Figure 2 - 13. CAN Module Bay shown with modules installed

The Module Bay also supplies cooling air to the modules. In order to ensure proper cooling, be
sure to cover any unused slots with the covers provided with your system.

WARNING!

Always cover any unused slots in the Module Bay. Failure to do so may
result in overheating of modules. Uncovered slots also increase the risk of
foreign objects falling into the module bay, possibly damaging sensitive
electronics due to electrical shorts. Take care to avoid dropping any objects
into the Module Bay.
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C HAPTER 3

Software

3.1 Overview

This chapter describes MultiVu, the Windows™ software that allows user control of the operation
of the VersaLab hardware. MultiVu combines, in a single user interface, the basic instrument
control, status reporting, and data collection (section 3.3); measurement options (section 3.4);
sequence editing and sequence execution (section 3.5); and graphing (section 3.6). In addition to
these features, MultiVu also contains instrument utilities, diagnostics, and error reporting.
Instructions for installing VersaLab MultiVu are given in section 3.2.

3.2 Installing VersalLab MultiVu

MultiVu may be freely installed on any computer. To install MultiVu, simply run the “Versalab
Setup.exe” program and follow the instructions provided within the setup program.

Figure 3-1. VersaLab MultiVu Setup Wizard main page
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3.2.1
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Note

Note

Note

If you are upgrading VersaLab MultiVu from an older installation package, system calibrations
(*.cal), configuration files (*.cfg), SROM, and user data should be backed up prior to using the
latest MultiVu installer. Also be sure to back up any calibrations for installed options. Once all
calibrations, configurations files, SROM, and data have been saved, the older version of
VersaLab MultiVu should be removed by launching the uninstaller through the computer’s
Control Panel.

Full Installation

To install MultiVu on a computer that is connected to your VersalLab system, select “Full
Installation” from the popup list in the “Select Components” step. Depending on the options that
are present in your system, you may also want to enable some of the option installers (Figure 3-2).

The CAN sub-system must be installed prior to installing VersaLab MultiVu (Section 3.2.2).

Figure 3-2. Components Selection Dialog - Full Installation

VersalLab MultiVu will flash modules that require firmware. Before beginning the full install,
it is important remember that the VersalLab has only four module bays; therefore only modules
that are in the module bays and options that do not require firmware will be available during
the installation. If you have more than four modules for your VersaLab system, the installer
will need to be run a second time.

WARNING!

Inserting or removing CAN Modules with the power ON may permanently damage
the electronics. Always turn OFF VersalLab when inserting or removing modules.
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QdCAN Installation

Before initiating the MultiVu installation (as described for the Full Installation above), the installer
will check the computer for the QdCAN directory. A warning will be issued if QdCAN cannot be
located (Figure 3-3), along with the steps carried out in the CAN-only installation.

Note Be sure to UNPLUG the CAN USB dongle from the computer before completing the
QdCAN installation.

Figure 3-3. QdCAN setup window

After clicking “OK” on the CAN-setup window, the installer window will show only QdCAN as
being checked in the list of items to install. Once the installation has completed, restart your
computer. Navigate to your computer’s Control Panel > Device Manager and PLUG-IN the CAN
USB dongle. After a few seconds, QdCAN should appear in the Device Manager list. At this
point the installer can be rerun for a Full, Custom, or Simulation installation of MultiVu and
firmware.

Custom Installation

Custom installations may also be performed on a computer connected to your VersalLab system. To
do so, select “Custom Installation” from the pull-down list in the “Select Components” step.
Depending on the options that are present in your system, you may also want to enable some of the
option installers (see Figure 3-4).

Figure 3-4. Components Selection Dialog for Custom MultiVu Installation
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3.24 Simulation Installation

To install MultiVu on a computer that is not connected to your VersaLab system, you would select
“Simulation Mode” from the popup list in the “Select Components” step — depending on the options
that are present in your system, you might want to enable some of the option installers as well (see
Figure 3-5).

Note Options selected during this installation mode will run as simulation when activated.

Figure 3-5. Components Selection Dialog for Simulation Mode Setup

Once installed, use the desktop icon for running MultiVu in simulation mode, which works without
VersalLab hardware attached. In simulation mode, MultiVu will not control the instrument, report
the instrument status, collect data, or execute sequences. Simulation mode allows you to use the
sequence editing and data graphing features of the software on office computers, and is not intended
for use on the VersalLab computer.
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3.25 Installing CAN Modules

You may need to install optional CAN modules in the VersaLab Module Bay before using a
measurement option. If the modules are already installed, you can leave them there, even if they are
not in use. If you need to insert modules, follow these steps:

1. Itis necessary to turn OFF VersaLab before inserting a module.

WARNING!

Inserting or removing CAN Modules with the power ON may permanently
damage the electronics. Always turn OFF VersalLab when inserting or removing
modules.

2. Remove the cover from the module slot where you intend to insert the module.

3. Carefully slide the module into the slot. The module should be oriented such that the bottom of
the text faces the front of VersalLab. You will feel the 9-pin D-shell connector on the module
mate with the module bay.

4. Once the module front panel is flush with the module bay, securely hand-tighten the screws on
the front panel to secure the module and properly ground its chassis.

5. Turn the power to VersaLab ON. Wait for it to boot. It may be necessary to restart MultiVu
and QDCAN Manager.

CAUTION!

Leaving VersaLab’s power OFF for longer than 10 minutes may cause the system to warm up
irreversibly. If this happens, another full cool down will be required. Try to minimize the
amount of time where VersalLab’s power is off.

After installing any modules, install the rest of the measurement option hardware as instructed
in the option manual. Then activate the option using the MultiVu menu item “Utilities >
Activate Option...” Select the desired option in the Option Manager window and click
“Activate -->>."

The option software will now appear. This software provides many functions, including a
wizard for inserting and removing samples, commands for performing immediate-mode
measurements, and sequence commands for automating measurements. Refer to the option
manual for details.
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3.2.6 Starting MultiVu

To start VersaLab MultiVu do one of the following: (a) double-click the desktop icon, or (b) open
the Windows Start menu and then locate and select the VersaLab MultiVu option. The VersaLab
MultiVu option may be located in the “Programs > Quantum Design” folder.

Figure 3-6. VersalLab MultiVu Icon

Wait for VersalLab MultiVu to start up. The VersaLab MultiVu interface opens, and in the center
of the interface, the initialization dialog box appears. This dialog box shows the progress of each
task the system perfoms as part of the system start-up. The dialog box disappears as soon as
initialization is complete.

Figure 3-7. System Start-up Progress Dialog

When the MultiVu software is not running, VersalLab goes into a standby state to prevent
equipment damage. Most users will leave MultiVu running on the VersaLab computer at all times.

You can monitor the system status when MultiVu is running, so Quantum Design recommends that
you leave MultiVu running even when you are not using the instrument but it is cold. If you warm
up the instrument, quit MultiVu before turning the system off.

3.2.7 MultiVVu Directories and Files

Table 3-1 on the following page lists the directories and descriptions of files associated with the
VersalLab MultiVu software.
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Table 3-1. VersalLab MultiVu Directories and Files

DIRECTORY

FILES

DESCRIPTION

MANUAL
REFERENCE

C:\QdVersaLab\

Root directory containing
all files related to
VersalLab MultiVu

C:\ QdVersaLab\Data

Default directory to store
all measurement data

C:\ QdVersalLab\Macros

Directory for basic scripts

342

C:\ QdVersaLab\MultiVu

Versalab.exe

VersalLab MultiVu
program file

*.dll

Libraries required for
VersalLab MultiVu (list of
files depends on installed
options)

*.chm

On-line manuals

Event.log

Log file containing
diagnostic information for
trouble shooting

BKG.dat

Data log that continuously
runs in the background of
the MultiVu program.
Useful for diagnostic
purposes.

veredist_x86.exe

Microsoft Visual C++
setup

C:\QdVersaLab\Qmaps

* .qmap

Definition files for
additional data logging

Appendix
B.2.3

C:\QdVersaLab\Sequence

Default directory to store
sequences

34

C:\ QdVersaLab\Tools

Export Data.exe

Utility to export data for
anaylsis and post
processing.

C:\\QdVersalLab\Wizards

* bas

*.0bm

Various script-based
utilities (and associated
files) which guide the user
through specific system
functions.

329
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3.3  Graphical User Interface

The main MultiVu window is shown in the figure below. This window displays essential status
information about the instrument and allows control of the instrument with simple mouse click
commands. The tool bar, control center, sequence command bar, and status bar may each be
docked and un-docked by double-clicking any non-control region or by dragging them around the
main window. They may also each be hidden using the “View” menu.

Figure 3-8. MultiVu Main Window

3.3.1 Menu Bar

The Menu Bar contains menus for accessing all fundamental software features.
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Figure 3-9. Main Menu Bar

FILE - File menu contains commands for opening, closing, and printing sequence files and
data files; for saving sequence files, graph files and graph template files; for generating
new sequence files; and for exporting data files to alternate formats.

EDIT - Edit menu contains commands to edit sequence files. It is not shown unless a
sequence window is selected.

VIEW - View menu allows you to show and hide the various components of the MultiVu
graphical user interface, and to open different types of data file windows (graph view,
table view, record view, raw data view.)

SAMPLE - Sample menu helps you install, remove, and locate samples and enter sample
properties that are recorded in the data file. This menu is populated only when a
measurement option is active.

SEQUENCE - Sequence menu contains commands to control the execution of sequences
and to access the underlying script for advanced sequence editing.

MEASURE - Measure menu contains commands to control measurements executed by
measurement options. This menu is populated only when a measurement option is active.

GRAPH - Graph menu helps you manipulate the appearance of data file graph windows.

INSTRUMENT - Instrument menu contains commands to control the temperature,
magnetic field, and atmosphere state of the sample chamber, and to put the instrument into
standby mode when unused.

UTILITIES - Utilities menu contains commands to activate and configure measurement
options, and to help maintain and troubleshoot the instrument, including cooling the
system down, regenerating the cryopump, logging diagnostic data, and viewing error
messages. (See Appendix B for more information.)

WINDOW - Window menu helps arrange the open windows in MultiVu.

HELP - Help menu contains version and serial number information about VersaLab, and
access to the user documentation.

Tool Bar

The Tool Bar contains shortcuts for common menu items.

Figure 3-10. Tool Bar
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3.3.3

3.34

3-10

Control Center

The Control Center (Figure 3-11) shows the currently selected sequence file name and sequence
execution status. In addition, there are buttons to change the selected sequence and edit, run, pause,
abort, or lock the selected sequence.

Figure 3-11. Sequence Control Center

Sequence Command Bar

The Sequence Command Bar (Figure 3-12) is shown when you edit sequences. You can toggle its
display by selecting the “View > Sequence Command Bar” entry while editing a sequence. It
contains commands you may insert into the sequence. Commands are organized in a tree structure.
Click “+” and “-” to expand or collapse tree branches. Double click commands to insert them into
the sequence. Measurement option sequence commands are present in the “Measurement
Commands” branch when a measurement option is active. More on sequences is found in the
section below.

Figure 3-12. Sequence Command Bar
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3.35 Status Bar

The Status Bar contains information about the status of the instrument. Click on the panels in the
status bar to access dialogs for setting temperature, magnetic field, and chamber atmosphere
actions.

| Sequence |dle | 21244K, Standby | -0.11 e, Standby [ 3.78 Ton |
| Seq: <none> | Set 2127TK | Set: 0.00 Oe [ Sealed | Momal Fower
| | 10.00 Kdmin, Fast Sette. | | 200,00 Oedsex. Linear [ |

Crpocoaler Active

< NOFEs

Sequence: Temperature: Magnetic Field: Sample Chamber: Cryocooler:
-status -present state -present state -pressure -status
file name -setpoint -setpoint -state -cooling power
-execution line -rate and mode -rate and mode

Figure 3-13. MultiVu's Versalab Status Bar

3.3.6 Sequence Window

The Sequence Window is used for editing sequences. More than one sequence window may be
open at a time. The selected sequence is always the sequence in the last sequence window that was
active (clicked). The control center reports the selected sequence file name. The selected sequence
is the sequence into which commands will be inserted when selected with the sequence command
bar. The selected sequence is also the sequence that executes when “Run Sequence” is selected,
when the control center “Run” button is selected, or when the menu command “Sequence > Run” is

selected.
i3

Figure 3-14. Run Button

3.3.7 Data Window (Table View)

The Data Window (Table View) shows a data file in table format. Each row in the table represents a
single data record. A data record consists of several data items collected simultaneously, such as
sample temperature, magnetic field, and magnetic moment. You may view a single data record in
its own window by double-clicking any record in the table view. Cells and groups of cells in the
table view can be selected, copied, and pasted into spreadsheets and other graphing programs for
additional analysis using the standard Windows™ copy and paste features.
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3.3.8 Data Window (Graph View)

The Data Window (Graph View) shows a data file in graph format. Each point on the graph
represents a single data record. A data record consists of several data items collected
simultaneously, such as sample temperature, magnetic field, and magnetic moment. You may view
a single data record in its own window by double-clicking any record in the graph view. The record
view and graph view are linked, so that the highlighted point on the graph view corresponds to the
record shown in the record view. The appearance of the graph view may be manipulated
extensively and templates may be applied to the graph view so that you do not need to set each
graph characteristic individually. To learn more about manipulating the graph view, see Section
3.6.

3.3.9 Instrument Utility Wizards

Under the menu item “Utilities > Wizards > you access utilities for performing tasks including
cryopump maintenance, cooling down the system, and resetting the magnet. When you start a
wizard, a dialog box opens and shows instructions to guide you through the process of executing
the utility. Follow the on-screen instructions, and consult the relevant section in Chapter 4: System
Operation for more details.

3.4  Measurement Options

Most measurements in VersalLab require the use of measurement option software. You do not use a
measurement option if you provide the measurement electronics, but all measurements provided by
Quantum Design require option software to be active. For details on the process of setting up a
measurement option, see the relevant option manual.

In order to activate an option, first set up the option hardware as described in the option manual.
Then select the menu item “Utilities > Activate Option...” You will be presented with a dialog
showing available measurement options. Select the desired option and press the “Activate -->>"
button. The option software will start within the MultiVu window, and will initialize the option
hardware. The measurement option will display a control center from which you can:

e  Configure the option

e Insert and remove samples

e  Setup data files

e  Perform immediate-mode (not sequenced) measurements

In order to perform sequenced measurements, you write and execute a sequence in MultiVu as
described in Section 3.5.
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Figure 3-15. VSM Option Control Centers

3.5

Sequences

Operation of VersaLab is automated using sequences. Sequences are simple computer programs
instructing the instrument to carry out a number of operations in a predetermined order. Simple
looping is supported in sequences, but branching is not. Operations typically found in a sequence
file include changing the sample temperature, changing the magnetic field, and measuring some
property of the sample (depending on which measurement option is active). Additionally,
commands may be placed in sequences to log diagnostic data, record a comment in the data file,
begin recording data to a new data file, generate a message on the computer screen, and even run
another sequence.

MultiVu is also used to run, pause, lock, and abort sequences on VersaLab and to view the status of
sequences as they run.
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35.1 Editing Sequences

e C(Create a new sequence file by clicking “New Sequence” E or selecting the menu item
“File > New Sequence.”

e  Open an existing sequence file for editing by clicking “Open Sequence” IE‘ or selecting
the menu item “File > Open... > Sequence.” You will be prompted to locate the file you
want to open.

e The top of the sequence window shows the sequence file name. An asterisk symbol (*)
after the file name means the sequence has changed since last time the file was saved.
Sequences must be saved before you run them.

e Save a sequence file by clicking “Save Sequence” El or selecting the menu item “File
Save.” If not already assigned, you will be prompted for a location and file name.

e Add a command to the selected sequence by double-clicking the command in the sequence
command bar. The new command is inserted above the highlighted command in the
selected sequence window. You will first be presented with a pop-up window to fill in
command-specific information. Then a summary of the command will appear in the
sequence window. More detail about each available sequence command is found at the end
of this section.

e Remove and reorganize sequence commands by highlighting them in the sequence
window and using the “Cut,” “Copy,” “Paste,” “Delete,” and “Undo” commands in the
“Edit” menu.

e Disable commands in a sequence file without deleting them using “Edit > Disable.” Enable
a disabled command with “Edit > Enable” (Figure 3-16). A disabled command will be
skipped during sequence execution. Disabled commands are preceded by an exclamation
mark symbol (“!”) in the sequence window and are changed from black text to gray text.
With this feature you may decide to execute or not execute some commands just prior to
run time based on the immediate circumstances. For example, you may wish to disable a
series of commands that fall outside the meaningful measurement range for certain
samples.

e All of the commands found in the “Edit” menu are duplicated in a pop-up menu when you
right-click any sequence window.

Figure 3-16. Disabling Sequence Commands
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3.5.2 Advanced Script Editing (Macros)
Before running sequences, MultiVu automatically compiles sequence files into Visual Basic for
Applications (VBA) scripts. Users with programming experience may compile this script without
running the sequence, and may then edit the script directly and run the edited script (macro). VBA
scripts give the user the ability to perform branching and more sophisticated loops than standard
sequences. Also, communication with third-party instruments via GPIB is possible in VBA scripts.
(You must supply GPIB hardware.)
However, Quantum Design cannot certify the instrument behavior when it is automated with user-
designed scripts. Many checks and safeguards can be bypassed when running a VBA script directly.
Novice users should not use this feature. Advanced users with programming experience should use
this feature with caution.

e Compile and edit the sequence script using the menu commands “Sequence > Advanced >
Compile Macro” and “Sequence > Advanced > Edit Macro.” A Sax Basic editor window
will appear.

e  Run the script with the menu command “Sequence > Advanced > Run Macro.” You will
be prompted to locate the script file to run. Or you may run the script by clicking the
“Start/Resume” button in the Sax Basic editor window.

e Find more information about the Sax BASIC editor and scripting language by right
clicking in the Sax BASIC editor window and selecting “Help > Editor Help” and “Help >
Language Help”.

3.5.3 Running Sequences
If the sequence file you want to run is not open, you need to open it. Open an existing sequence file
by clicking “Open Sequence” \E‘ or selecting the menu item “File > Open... > Sequence.” You
will be prompted to locate the file you want to open.

e To execute a sequence, it must be the selected sequence. If more than one sequence
window is open, make sure the selected sequence is the sequence you want to execute.

e Execute the selected sequence by:

o Selecting “Run Sequence” ﬂ
OR

o Selecting the menu command “Sequence > Run.”
OR

o Selecting the “Run” button on the control center.

e The status bar and the control center both display the status of the sequence execution. The
sequence window also highlights the line currently being executed in green.

e The toolbar, “Sequence” menu, and command center all provide the ability to pause (Iﬂ)
and abort u ) sequence execution also. When paused, the sequence window highlights
the active line of the sequence in yellow.
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Locking Sequence Execution

When the sequence execution is locked, a sequence cannot be run, paused, or aborted
without first unlocking sequence execution. You cannot exit MultiVu when sequence
execution is locked.

No key or password is required to lock or unlock sequence execution. The feature is
intended only to prevent careless and accidental interference with instrument operation. It
is not a security device and does not protect against malicious behavior.

The instrument does not need to be running a sequence to lock sequence execution.

Lock sequence execution by clicking “Lock Sequence” I@, selecting the menu item
“Sequence > Lock,” or click the “Lock” button on the control center. Type in your name
and additional information so other users know why the sequence is locked, then click the
“Lock” button. All run, pause, and abort controls in the graphical user interface are
disabled.

Unlock the sequence by clicking “Lock Sequence” @ again, selecting the menu item
“Sequence > Unlock,” or the “Unlock” button on the control center. Then click the
“Unlock” button on the popup dialog, which displays the name and message of the person
who locked sequence execution.

Sequence Commands

The following sequence commands are present in VersaLab with no measurement option activated.
Additional measurement commands are available when using an option.

3.55.1
o

SYSTEM COMMANDS
Beep — Causes the computer to make the Windows default beep sound.

Call Sequence — Suspends execution of parent sequence file and begins execution of
selected child sequence file or script file. When execution of child sequence file or script is
complete, execution of parent sequence will continue with the next line.

Chamber Operations — Changes the state of the sample chamber atmosphere.
(Figure. 3-17). See section 2.5.6 for a description of chamber operations.

Figure 3-17. Sample Chamber Atmosphere Control Center
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Remark — Serves as a message, comment, or visual break for the user only. Does nothing
during sequence execution.

Scan Field — Creates a program loop for executing repeated commands at user-defined
magnetic field increments. All commands between the “Scan Field...” line in the sequence
and the “End Scan” line in the sequence will be repeated at each magnetic field specified
by the scan field command. Set the initial and final fields and the scale on which the field
increments should appear uniform (linear, H, H"2, 1/H, log (H)). Also set the total number
of field steps. (For uniform linear spacing, you may alternatively set the field increment.)
Finally, specify the rate and approach mode used by the magnet controller to achieve each
set point:

o Linear: Controller will drive directly to each field and attempt to maintain the
specified charging rate as closely as possible until each set point is reached. At each
set point the field will stabilize until the commands within the loop are completed.

o Oscillate: Controller will intentionally overshoot each set point by 70% of the total
field change, at the desired rate, and will then oscillate into the set point field in
smaller and smaller overshooting steps. At each set point the field will stabilize until
the commands within the loop are completed. This is intended to eliminate flux
motion in the superconducting magnet windings, yielding a very stable magnetic field
and reduced remanence.

o Sweep: Controller will drive directly from the initial field to the final field without
stopping. Each time a field increment defined by the command is reached, the
commands inside the scan field loop will be executed, but the field will continue to
ramp while they execute.

Scan Temperature — Creates a program loop for executi